
 

Synaptic Labs'
HyperBus Memory Controller (HBMC)
Tutorial

T002A:  A Qsys based Nios II reference design using 
Intel’s MSGDMA to benchmark memory copy operations 
on the HyperRAM device using S/Labs' HBMC IP

This stand-alone tutorial describes a simple benchmarking reference design for S/Labs HBMC IP 
targeted specifically to Intel Cyclone 10LP evaluation board or devboards GmbH HyperMAX 10M25 
and 10M50 boards.   This reference design is based on Intel’s MSGDMA reference project1.  This 
tutorial does not depend on, and does not require familiarity with, any of the other tutorials for S/Labs 
HBMC IP. 

HBMC customers interested to benchmark the performance of large burst memory transfer requests on 
the HyperMAX/ Intel Cyclone 10LP evaluation board will want to explore this tutorial.  Generally 
speaking, doubling the burst length of a memory transfer request addressed to a HyperBus devices 
results in around a 25% increase in effective bandwidth.  When considering memory access contention 
latency vs. effective bandwidth trade off, the latency vs. performance sweet spot is has a burst memory 
transfer request length of around around 64 to 256 bytes.  Additionally, increasing the HyperBus 
channel clock speed achieves a near linear increase in effective bandwidth along with a sub-linear 
decrease in contention access latencies.  Developers can use this reference project to quickly explore 
these and various other trade-offs.  

This tutorial describes key aspects of a pre-configured .qsys reference project and then walks through 
the process of generating and compiling that .Qsys project.  This tutorial then describes how to compile
the example Nios II source code that controls Intel’s MSGDMA and then run the reference design on 
the development board. 

1  http://www.alterawiki.com/wiki/Modular_SGDMA 
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Set-Up Requirements:

a. Step 1:   Obtain core materials

2. Download and install Quartus Prime Standard/Lite 17.0 on your PC, please 
ensure that your PC meets the required minimum specification.

3. For Intel's C10LP Evaluation board :

a. Create a folder/directory for your work. We suggest:  C:\C10_lab\ 

b.  Download reference design HyperNios_Project_C10LP from: 
http://media.synaptic-labs.com/pub/2017-Designs/SynapticLabs-HBMC-Tutorial-
001/HyperNios_Project_C10LP.zip

c. Extract to: C:\C10_lab\  

4. For devboards HyperMAX board :

a. Create a folder/directory for your work. We suggest:  C:\HyperMAX_lab

b.  Download reference design HyperNios_Project_HM10M25 from:
http://media.synaptic-labs.com/pub/2017-Designs/SynapticLabs-HBMC-Tutorial-
001/HyperNios_Project_HM10M25.zip

c.  Extract to: C:\HyperMAX_lab\ 

Step 2:   License Setup

1. Next you need to apply for Synaptic Labs' HyperBus Memory Controller license.  
You can skip this step if you already installed the license at some earlier stage.

Free enrollment can be obtained from:

http://opencore_license_001.synaptic-labs.com/

2. Synaptic Labs offers two Installation Guides that:

a. Begin by preparing you to enroll to receive a Basic Edition (OpenCore) 
license 

b. Guide you on how to install the license file you will receive after enrolment

c. Guide you on how to install the Qsys components that you will receive after 
enrollment
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3. Please download and read one of those Installation Guides: 

a. Developers familiar with installing third party IP into Quartus will probably 
prefer the streamlined: 
HBMC IP Installation Guide for Experience Developers.

b. All other developers should download the:
HBMC IP Installation Guide with Detailed Step-by-Step Instructions.  

Step 3:   Install HBMC Qsys Component into the project IP Folder

1. In this tutorial we assume that S/Labs HyperBus Memory Controller (HBMC) will 
be located in the Project directory. 

a. Other Qsys component installation methods are described in the above 
mentioned installation Guides. 

2. Download the latest version of Synaptic Labs' HBMC IP from: 

http://media.synaptic-labs.com/pub/SoftIP/latest_sll_ca_hbmc_001_be_cots.zip

3. For Intel's C10LP Evaluation board :

◦ Extract to the project/ip directory :     
C:\C10_lab\MSGDMA_project_C10LP\ip

4. For devboards HyperMAX board :

◦ Extract to the project/ip directory : 
C:\C10_lab\MSGDMA_project_HM10M25\ip
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Step 4:  Cyclone 10 LP Development Board  DIP Switches

You have the Cyclone 10 LP evaluation board and mini USB cable provided. 
Note: the board is powered over USB so no power supply is required.

Ensure that DIP Switch 4 on the Cyclone 10 board is set to ON, this bypasses the 
virtual JTAG system and simplifies board programming.
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1.  Contents of the reference project
Synaptic Labs' HyperBus Memory Controller (HBMC) Reference design bundle includes the 
following files and directories: 

MSGDMA_Project_C10LP(MSGDMA_Project_HM10M25) folder contains the Quartus 
Prime and Qsys project files for this reference project.

MSGDMA_Project_C10LP(MSGDMA_Project_HM10M25)→ ip folder will contain S/Labs 
HBMC encrypted ip (refer to Setup requirements: step3 for more info)

The MSGDMA_Project_C10LP(MSGDMA_Project_HM10M25) → software folder is the 
workspace folder for Eclipse

The MSGDMA_Project_C10LP(MSGDMA_Project_HM10M25) →source folder contains 
the source code for:

• Intel’s MSGDMA project, adapted for use with the HyperRAM memories.

Note:  Synaptic Labs' HyperBus Memory Controller (HBMC) IP can ONLY be simulated with 
Altera's Modelsim Simulator.   Please contact Synaptic Labs for a simulation model if required.

2.  Open the reference Quartus Project 
• In the menu bar of Quartus Prime, select File → Open Project… 

• Select the file HyperNios_MSGDMA.qpf in the project directory

• Click the [ Open ] button. 
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2.1  Check the correct FPGA device is selected
• Every Quartus project is targeted to a specific FPGA device.  For  devboards GmbH 

HyperMAX 10M25 and 10M50 boards, check that the FPGA device matches the one 
being used.   This step is not needed for Intel C10LP evaluation board.

• The HyperMAX 10M25 board employs the 10M25DAF256C7G device.
The HyperMAX 10M50 board employs the 10M50DAF256I7G device.

• The Intel C10LP Evaluation board employs  the 10CL025YU256I7G device

• If you need to change the FPGA device for your specific board:   

◦ Ensure that there are no instances of the Qsys application running. 
◦ Right click on the device name.     
◦ Select “Devices…” in the pop up window.  
◦ A new window will open.  Select the “Device” tab. 
◦ Copy the required device name into the “Name filter:” field. 
◦ A popup window will ask: “Do you want to remove all location assignments?” 

Click on the [ No ] button.
◦ Select the requested device in the “available devices:” field so that it is highlighted in 

blue.
◦ Then click on the [ Okay ] button. 

• The Quartus project and the Qsys project are now configured for the FPGA device you 
selected.

3.  Open the reference Qsys project
• In the menu bar of Quartus Prime, select  Tools→Qsys
• Select the file system.qsys in the project directory
• Click the [ Open ] button. 
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4.  Explore and configure the reference Qsys project

4.1  Components employed in the reference project
The reference Qsys project in this tutorial employs a NiosII/f processor, Synaptic Labs' 
HyperBus Memory Controller (HBMC) IP,  Altera’s On-chip Memory module to store code and 
data in on chip SRAM, the Altera Modular Scatter Gather Direct Memory Access (SGDMA) 
Dispatcher and various peripherals such as Altera’s JTAG UART and timer modules as illustrated
below.  All these Qsys components are connected together. 

Please note that the 50 MHz clock pin of the FPGA is mapped to the  in_clk  port of S/Labs 
HyperBus Memory Controller instance.    The HBMC instance includes an integrated PLL that 
generates the clocks to drive the Avalon bus and the HyperBus memory channel.  In particular 
the  o_av_out_clk  port of the HBMC is used to drive the Avalon bus and all of the components 
illustrated above. 
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4.2  Nios II/f Gen2 processor configuration
In this example, the Nios II/f Reset and Exception vectors are mapped to onchip_memory as 
illustrated below.  This means that the Nios II/f processor will look for the boot code and 
exception handling / interrupt code in the onchip_memory module.

As illustrated below, the instruction and data caches of the Nios II/f core have both been set to 
4Kbytes in size to accelerate software performance.   The instruction and data caches have both 
been configured with their burstcount signal enabled so that both caches issue 32-byte burst 
memory transfer requests.  This is done because:  (a) the HyperBus protocol employs burst 
memory transfer requests with closed page mode of operation; and (b) SLL’s HBMC employs an 
Avalon interface with burst mode of operation.
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4.3  Configuring S/Labs HyperBus Memory Controller 
Synaptic Labs' HyperBus Memory Controller has been pre-configured in this reference project.  
In this section we will describe various configuration options that you may wish to change. 

In the "Master Configuration" tab

The open-core edition of SLL HBMC IP only supports HyperRAM.  The full edition of SLL 
HBMC IP supports any combination of HyperFlash and HyperRAM.   Both editions offer 
preconfigured memory options for supported COTS FPGA development boards.   The full 
edition of SLL HBMC IP also includes the option to manually configure the HyperBus devices. 

To configure the project to just use HyperRAM on the HyperMAX/Intel C10LP evaluation 
board:

• The FPGA board type field is set to either: 
◦ Devboards - HyperMAX 10M25 (HyperRAM) or
◦ Devboards - HyperMAX 10M50 (HyperRAM) or
◦ Intel – Cyclone 10LP Evaluation Kit (HyperRAM) 

To configure the project to use both HyperFlash and HyperRAM on the HyperMAX board: 

• The FPGA board type field is set to either: 
◦ Devboards - HyperMAX 10M25 (HyperFlash and HyperRAM) or
◦ Devboards - HyperMAX 10M50 (HyperFlash and HyperRAM) 

Currently, Intel's Cyclone 10LP evaluation board does not  contain a HyperFlash device.
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This tutorial is written assuming the use of (HyperRAM) only. 

…...for Devboards HyperMAX board

…...for Intel Cyclone 10LP Evaluation Kit
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In the Clock and PLL Configuration Tab (opencore edition)

• The Avalon and HyperBus clock configuration field is set to  One clock

• The HyperBus channel clock frequency field is set to  100 MHz 

In the Clock and PLL Configuration Tab (full edition)

• The  Avalon and HyperBus clock configuration  field is set to  Two clocks

• The  HyperBus channel clock frequency  field is set to  150 MHz 

• The  Shared Avalon clock frequency  field is set to  100 MHz 

In the Ingress Avalon Slave 0 (IAVS0) configuration tab
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The IAVS0 port is used to access all HyperBus memories connected to the HyperBus Memory 
Controller IP.  The most common configuration of the IAVS0 port is as follows: 

IAVS0: Ingress Avalon port stage

• The Enable Avalon write capability field is checked
• The Enable Avalon byte-enable capability field is checked
• The Register Avalon Write data field is left unchecked

   
IAVS0: Burst Converter and address decoder stage

• The  max BurstSize (in Words)  field is set to 8 words  

◦ The full edition of S/Labs HBMC IP supports long bursts:
  8 words =   32 bytes
16 words =   64 bytes
32 words = 128 bytes
64 words = 256 bytes
…

◦ Generally speaking, doubling the burst length of a memory transfer request 
addressed to a HyperBus devices results in around a 25% increase in effective 
bandwidth.  

◦ When considering memory access contention latency vs. effective bandwidth trade 
off, the latency vs. performance sweet spot is has a burst memory transfer request 
length of around around 64 to 256 bytes. 

• In this tutorial, set the  lineWrapBursts  field to true
◦ LineWrapBursts are used to accelerate the Nios II cache accesses to HyperBus 

devices.
◦ LineWrapBursts are currently only supported by S/Labs HBMC IP when the value of

the
max BurstSize is 8 words. 

IAVS0: Ingress Avalon return stage

• The  Register Avalon Read data path  field is left unchecked
• The  Use Avalon Transaction Response  field is left unchecked
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The GUI interface includes significant inbuilt documentation.  Moving your mouse over a 
configuration field pops up the on-screen help for that field. 
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In the Device 0 Info tab

The “Device 0 Info” tab provides information about the HyperBus device connected to chip 
select 0.  If in the "Master Configuration" tab, the FPGA board type field is set to Devboards - 
HyperMAX 10M25/50 (HyperRAM) or Intel – Cyclone 10LP Evaluation Kit 
(HyperRAM),, these fields remain empty.

If in the "Master Configuration" tab, the FPGA board type field is set to Devboards - 
HyperMAX 10M25/50 (HyperFlash and HyperRAM), the following table will show the 
parameters, configuration and timing for the HyperFlash memory.

Device 0 Configuration

• In this tutorial the Use factory default settings for this HyperBus device field is left 
checked
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In the Device1 Info tab

The table below will show the parameters, configuration and timing for the HyperRAM memory.

Device 1 Configuration

• In this tutorial the Use factory default settings for this HyperBus device field is left 
checked

The exact parameters on your screen may be different because: 

• The HyperMAX 10M25 board employs a   64 Megabit HyperRAM device.
• The HyperMAX 10M50 board employs a 128 Megabit HyperRAM device.
• The Intel C10LP Evaluation kit employs a 128 Megabit HyperRAM device.
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4.4  Configuration of Altera’s On-Chip Memory
In this reference project, Altera's On-Chip Memory is configured as a 40 Kilobyte single port 
RAM.  We will setup this memory to be initialized by the Nios II SBT for Eclipse 

• Please ensure that: 

◦ [x] Initialize memory content is Ticked

◦ [x] Enable non-default initialization file is Ticked

◦ [x] User created initialization file is  onchip_memory.hex

Note:  If you do not specify an initial .hex filename, Nios II SBT will not generate the
memory initialization file.  After we have generated that file, we will then need to 
update Qsys with the relative/full path to the .hex file.
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4.5  Configuration of Intel’s dma_read_master and 
dma_write_master modules

In this reference project, both of Intel’s dma_read_master and dma_write_master modules are 
configured to employ burst memory transfer requests of 8 words (32 bytes) in length.  You can 
adjust the burst length of each module in its respective graphical user interface:

 

If you increase the burst length of the dma_read_master and/or dma_write_master module,  
you must also ensure that the maxBurstSize of S/Labs HBMC IP is set to a value of equal or 
larger burst length.
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5.  Generating the Qsys Design
Once the Qsys project has been correctly configured, press the [ Generate HDL… ] button on 
the bottom right hand side of the Qsys window.    

• In the Synthesis section, set the Create HDL design files for synthesis field to Verilog. 

• In the Simulation section, set the Create simulation model field to None. 

• Then click on the [ Generate ] button.

• You may see a Save System window.  Click the [ Close ] button to close the save window.

• Generating the .qsys project updates the .SOPC file which will be used by the Nios II 
Software Build Tools (SBT) environment. 

• Click the [ Close ] button to close the generate window.

• You may want to close the Qsys window. 
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6.  Preparing the firmware 

6.1  Open the NIOS II Software Built Tools for Eclipse
• In Quartus Prime, go to the menu bar and select 

Tools → NIOS II Software Built Tools for Eclipse.

• Click the [Browse…] button.  A new file selector window will open.  In this tutorial we 
are going to select the software folder located inside the project folder as the 
workspace and then click the [ OK ] button. 

• Be sure to leave the [ ] Use this as the default field unticked.

• Click the [ OK ] button.
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6.2  Create a simple application and BSP
The software folder in the reference project is empty. This is because problems can be 
experienced when moving the Eclipse Workshop folder between Windows and Linux Systems.  
We need to create a Nios II application, and Nios II board support package for that Nios II 
application:

• In the Eclipse window, go the menu bar and select: 

File → New → NIOS II Application and BSP from Template

• A new window will pop up:  (most of the fields below will initially be empty)
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• In the Target hardware information, click on the […] button

• A file browser window will open.  Locate and select the  system.sopcinfo  file generated 

by Qsys and stored in the project directory. Click [Open]. 

• It may take around 30 seconds for the Eclipse application to parse the .sopcinfo file. 

• Select a Project name.  In this example, we are using HelloWorld as the project name.

• Ensure that:  [x] Use default location  is ticked.

• We now need to select a template from the Project Template list.  

In this example, select the  Hello World  template.    

• Press the [ Finish ] button to complete the current step.

The Nios II SBT will now generate:

• a HelloWorld application folder that contains the hello_world.c file.   We will replace 

that hello_world.c  file with a custom program that tests the HyperRAM device later in 
this tutorial. 

• a HelloWorld_bsp  folder that contains the Nios II Board Support Package (BSP) 

hardware abstraction layer (HAL). 
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6.3  Configure the Board Support Package (BSP)
The Nios II BSP must be configured before we can compile the source code.

• In the Project Explorer tab, right click on: 
HelloWorld_bsp → Nios II ->  BSP Editor...
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In the Main Tab of the BSP editor, in the panel on the left hand side, select: 

Settings  → Common

• Set the  sys_clk_timer  field to none
This is used to generate a recurring system clock interrupt for the hardware abstraction 
layer.

• Set the  timestamp_timer  field to timer_0 
This field is used to enable the hardware abstraction layer to perform fine precision 
timing.

• The Newlib ANSI C standard library can be configured as small or normal

• Generally, when mapping code and data to on-chip memory:
◦ Tick the  [x] Enable small C library  field to reduce the size of the executable code 

generated by the hardware abstraction layer (HAL).  Ticking this option also reduces 
the functionality and performance of the HAL.  Please note that the inbuilt memset() 
and memcpy() routines will be very slow.

• Generally, when mapping code and data to HyperRAM and/or HyperFlash:
◦ Untick the  [ ] Enable small C library  field to increase the functionality and 

performance of the executable code generated by the hardware abstraction layer 
(HAL).  The inbuilt memset() and memcpy() routines will achieve good 
performance.  However, the executable code will be considerably larger.

• It is important to Tick the  [x] Enable small C library for this specific tutorial.
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In the Main Tab of the BSP editor, in the panel on the left hand side, select: 

Settings → Advanced →  hal.linker 

For the purpose of this tutorial, the following configuration will generally work: 

• Tick [x] allow_code_at_reset
• Tick [x] enable_alt_load
• Tick [x] enable_alt_load_copy_rodata
• Tick [x] enable_alt_load_copy_rwdata
• Tick [x] enable_alt_load_copy_exception
• UnTick [ ] enable_exception_stack

However, this specific configuration may not be the best configuration for your project’s needs.  

Please refer to Altera’s documentation for detailed information on how to setup the hal.linker 
fields:

Generic Nios II Booting Methods User Guide, UG-20001, 2016.05.24
https://www.altera.com/content/dam/altera-
www/global/en_US/pdfs/literature/ug/niosii_generic_booting_methods.pdf  
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Select the Linker Script Tab of the BSP editor.

For this tutorial example, we are going to:

• Map the reset vector (.reset) to the onchip memory (onchip_memory2_0) . 
This is generated by Qsys and depends on the location of the Nios II reset vector.

• Map the exception vector (.exceptions) to the onchip memory (onchip_memory2_0). 
This is generated by Qsys and depends on the location of the Nios II exception vector.

• Map the instruction code (.text) in the onchip memory (onchip_memory2_0)
 

• Map all other data regions (.bss, .heap, .rodata, .rwdata, .stack) to the onchip memory 
(onchip_memory2_0) 

This will map all memory regions generated by the GCC tools to the on-chip SRAM.   Also see: 
Nios II Gen2 Software Developer's Handbook, NII5V2Gen2, 2017.05.08
Section 5, Nios II Software Build Tools

    https://www.altera.com/content/dam/altera-www/global/en_US/pdfs/literature/hb/nios2/n2sw_nii5v2gen2.pdf

 Now:

• Click on the [ Exit ] button on the bottom right hand corner of the BSP Editor window.  

• Then click on the [Yes, Save] button on the Save Changes window to save the BSP 

settings.
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For this tutorial, we need to reduce the size of the executable code generated for the Newlib 
ANSI C standard library:

• Right click on HelloWorld_bsp
• A popup window appears. Select Properties
• A new window called “Properties for HelloWorld_bsp” opens.
• Left click on Nios II BSP Properties
• Set Optimization Level:  SIZE.   ← Compiler will now generate smaller object code
• Click the [ Apply ] button.
• Click the [ OK ] button.

The standard ANSI C functions will now be optimized by gcc for smaller object code size, 
resulting in more on-chip SRAM being available for the .stack and .heap sections.
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6.4  Generate the BSP and clean the project
The software developer must re-generate the BSP every time the Qsys project is regenerated.  
This ensures that the device drivers and addresses of peripherals are reflected correctly in the 
hardware abstract library.  To (re)generate the BSP: 

• Go to the Nios II eclipse window.

• Right click on HelloWorld_bsp project then select Nios II then select Generate BSP.

• Right click on the HelloWorld_bsp project then select Clean Project to delete any 
intermediate files generated by the gcc compiler for this application library.  

• Right click on the HelloWorld project then select Clean Project to delete any 
intermediate files generated by the gcc compiler for this application folder.
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6.5  Install the memory bandwidth benchmarking source 
code

• We now want to replace the original HelloWorld.c source code with software that 
benchmarks the HyperRAM.  Copy and replace the files located in: 

◦ MSGDMA_Project/source/

     to:

◦ MSGDMA_Project/software/HelloWorld

• In the project explorer window of Eclipse, right click on the HelloWorld folder. Then
select Refresh.  The new source code files should now be visible within Eclipse. 

---------------------------------------- Important ----------------------------------------

If the FPGA board type field of the "Master Configuration" tab of the HBMC IP, is set to 
Devboards - HyperMAX 10M25/50 (HyperFlash and HyperRAM), then please  
// COMMENT out line 8 in the new  hello_world.c  file.

From a HyperRAM only configuration:

To a HyperFlash and HyperRAM configuration: 
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6.6  Build the Nios II Application
We now want to run the compiler and linker:

• Go to the Nios II eclipse window.

• Go to the menu bar and select: 
Project ->Build All 

• If the project produces warning / error messages, you may need to build the project 
twice. 

The HelloWorld executable firmware (.ELF) is now generated.  The .ELF can be downloaded 
directly into on-chip SRAM using the Nios II Software Development files.  

However, the .ELF file itself cannot be embedded directly into the FPGA bitstream file, or 
programmed directly into the HyperFlash memory.  To do that, we need to convert the .ELF file 
into one or more memory initialization files. 
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6.7  Generate memory initialization files 
If we want to embed the firmware into the on-chip SRAM when configuration the FPGA device 
using a FPGA bitstream, or if we wish to program the HyperFlash memories, we need to 
generate “memory initialisation” .hex files from the .elf file. 

• In the Project Explorer tab, right click on: 
HelloWorld  -> Make Targets → Build…

• A Make Targets window will open.   

• Select  mem_init_generate and 
click on the Build button.

• New hex files will be generated.   

These files will be located in  
   Project_dir →
       Software → 
          HelloWorld →
             mem_init

 
The file onchip_memory.hex can be embedded into the FPGA bitstream to initialize the onchip-
memory as described in the next section.
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7.  Update the memory initialization field(s) in Qsys
Before synthesizing the design, it is important to ensure that the initialization file for the onchip-
memory is set to the exact path of the .hex file in the Qsys project.  This is because it is possible
to create multiple applications within a Nios II Eclipse workspace, each with its own firmware 
and memory initialisation files. 

• In Qsys, open the hypernios.qsys project.  
• Open the parameters for the On-Chip Memory module.  
• Ensure that the User created initialization file points to the onchip_memory.hex file 

generated by NIOS II SBT for Eclipse for the application you want to use.   In this 
tutorial we only have one Nios II application located in the software/HelloWorld folder.

• We recommend typing in the filename with a relative path: 

./software/HelloWorld/mem_init/onchip_memory.hex

• Each time you change the Qsys project, you will need to:
◦ Save and regenerate the Qsys design
◦ Then regenerate the Nios II BSP
◦ Then clean the projects and rebuild the (.elf) Nios II Application
◦ Then regenerate the (.hex) memory initialization binaries

• As we have now changed the Qsys project, you will need to execute the above steps. 
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8.  Synthesize and assemble the Design
• Go to the Quartus Prime window.

• In the menu bar, select:
Processing → Start Compilation

Windows users, please note:  If the compilation fails to start you may need to reduce the 
path length of your project folder. This is because some versions of Windows have a 
maximum path length of 260 characters which can be exceeded when compiling projects 
in Quartus Prime.
If you change the path, make sure all .hex files in the Qsys project are set correctly.  

• The assembler step will create the SRAM FPGA Bitstream file (.SOF) with the memory 
initialisation file (.hex) for the SRAM embedded in that FPGA Bitstream file.

• If at a later time you recompile your Nios II Code, you will need to embed the new .hex 
files into the FPGA bitstream.  The fastest way to do this is:
 
◦ In the menu bar, select:

Processing → Update Memory Initialization File
This ensures the latest version of the .hex file will be used during the assembly step. 

◦ In the menu bar, select:
Processing → Start → Start Assembler
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9.  Program the FPGA Bitstream into the FPGA device
• Connect the HyperMAX/Intel C10LP Evaluation kit to the USB port of your computer

• Open the Quartus Prime window

• In the menubar, click on Tools then Programmer to start the Altera Programmer 

|

• Click on “Hardware Setup…”.  A new window will open. 
• Double Click on the HyperMax (or Intel C10LP Evaluation kit)  device, then click the 

[ Close ] button. 

• If the  HyperNios_MSGDMA_time_limited.sof  is not already selected:
◦ Click “Add File...” in the programmer window.
◦ Go to the output_files folder
◦ Double click on HyperNios_MSGDMA_time_limited.sof

• Click the [ Start ] button and the FPGA bitstream will be programmed into the 
SRAM configuration memory of the FPGA device. 

• A window called “OpenCore Plus Status” should open. 
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10.  Run the nios2-terminal application
• In Linux:   Open a Linux command shell / terminal
• In Windows: Run the Nios II Command Shell application from the Windows start 

menu. 

• Run the nios2-terminal command from the terminal. 
• Messages similar to the one below should be displayed in the command shell. 
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